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TIN HỌC VĂN PHÒNG 

1. Microsoft word 
1.1 Giới thiệu về MS Word 

 MS Word là phần mềm chạy trong môi trường Windows, chuyên dùng để soạn 
thảo văn bản, phục vụ cho công tác văn phòng, có các tính năng như:  

- Giao diện đồ hoạ thông qua hệ thống thực đơn và các hộp hội thoại  
- Có khả năng giao tiếp dữ liệu với các ứng dụng khác 
- Chức năng tạo bảng biểu mạnh và dễ dùng. 

 2

Formating toolbar: 
Thanh công cụ chứa các 
nút lệnh hoặc cửa sổ phục 
vụ cho việc định dạng văn 
bản.

Menu bar: Thanh trình 
đơn, chứa các nhóm 
lệnh, mỗi nhóm lệnh 
ứng với một số  tác vụ. 

Standard Toolbar: 
Thanh công cụ, chứa 
các nút lệnh thực thi 
các tác vụ 

Bấm vào đây 
để thoát khỏi 
MS Word. 

Lựa chọn 
Font chữ 

Lựa chọn 
cỡ chữ 

Mở một 
tập tin Word 
đã có. 

Mở một 
tập tin 
Word mới 

 Lưu lại 
tập tin đang 
soạn thảo...  

a) Khởi động MS Word 
Có thể dùng một trong hai cách sau:  

Cách 1: Nếu khởi động máy xong trên góc 
phải cao nhất của màn hình có thanh biểu 
tượng Shortcut   ta bấm vào 

 
 
Cách 2: Bấm vào nút lệnh Start ở góc trái 
dưới cùng → Prorgam → Tìm đến mục 
Microsoft Word.  
 
b) Tạo mới một tệp tin, lưu tập tin vừa 
soạn thảo 
 

Khi vào MS Word, tiến hành soạn thảo 
văn bản, nếu muốn lưu văn bản đã soạn thảo, 



 
 

bạn bấm biểu tượng  th
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ì sẽ xuất hiện hộp hội thoại có chứa các thành phần sau: 
 

 
 

 
 
 
 

i một tệp 
ở mới 

p tin đã 

 vào biểu 
 trên thanh 

ại dưới 
đ  đĩa, 
th tin có 
từ trước đó, chọn tên tập 
tin, nhấn phím Enter 

oặc ấn nút Open để 
ở

1.2 định dạng văn bản. 
a)  giao diện MS Word  

 
Bấm vào 

 và chỉ ra ổ 
đĩa và thư 

 
 
 
 
 

Chỉ ra kiểu tập tin cần lưu 
trữ, mặc định là tập tin 
được lưu với đuôi “.doc”. 
Bạn có thể lưu tập tin với 
đuôi “.txt”,...

hộp thoại 

mục cần 
chứa tập 
tin. 

 
 
 
 
 
 
 
 

c)  Mở mớ
tin đã có
một tậ
có: 
Bấm

tượng Open
c

Gõ vào tên tập 
tin.(Nên chọn tên 
có tính gợi nhớ. 

Bấm nút Sa
lưu lại tập t

ve để 
. in

ông cụ hộp tho
ây xuất hiện, tìm ổ
ư mục chứa tập 

h
m . 

 

Soạn thảo và 
Gõ tiếng Việt trong

 



 
 

 
Khởi động chương trình 
Vietkey. Ấn nút này để 
chương trình hiển thị ở góc 
phải dưới cùng màn hình.

Chọn chế độ gõ tiếng 
Việt, sao cho biểu tượng 
này là chữ V. Nếu biểu 
tượng này là chữ E là 
đang ở chế độ gõ tiếng 
Anh. 

   
 
 
 
 

 
 
 
 
 
 

 

 
 
 

 
Chú ý: Để gõ Tiếng Việt hiệu quả, bạn nên tập gõ mười ngón. 

b) Các thao tác trong màn hình soạn thảo MS Word 
Di chuyển con trỏ:  

- Con trỏ nháy trên màn hình là để xác định vị trí của ta tại văn bản.  
- Có thể dùng chuột để chọn vị trí con trỏ hoặc dùng bàn phím.  

rỏ: 
n xuống: con trỏ được di 

 một trong văn bản. 
uyển con trỏ về đầu dòng. 

ng trang một. 

hao tác tiếp theo sẽ chỉ tác động lên 
khối v ác. 

- ng kéo, chuột đi đến đâu là văn 

- ím Shift kèm theo bấm phím → (hoặc ←) 

g cách chọn khối văn bản 

- họn: được thực hiện bằng cách chọn khối văn bản rồi 
. 

 

 
 
 
 

- Các nút (phím) trên bàn phím giúp di chuyển vị trí con t
+ Sử dụng các phím hình mũi tên sang trái, phải, lê

chuyển từng ký tự
+ Phím Home: di ch
+ Phím End: di chuyển con trỏ về cuối dòng. 
+ Phím Page Up, Page Down: di chuyển con trỏ lên xuống từ
Kh
Khi văn bản đã được khối chọn thì các t

ối chọn văn bản:  

ăn bản đó mà không tác động lên phần văn bản kh
Cách 1: bấm chuột trái, giữ nguyên và miết xuố
bản được bôi đen đến đó. 
Cách 2: nhấn và giữ ph
Thao tác với khối văn bản đã chọn: 

- Sao chép khối văn bản đã chọn: được thực hiện bằn
rồi nhấn phím Ctrl + C, sau đó chỉ chuột đến vị trí mới nhấn Ctrl + V. 
Cắt dán khối văn bản đã c
nhấn phím Ctrl + X, sau đó chỉ chuột đến vị trí mới nhấn Ctrl + V
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c) Các ọn   thao tác định dạng khối văn bản đã ch

- Chọn Font chữ: Khối chọn văn bản cần thay đổi font chữ, bấm tìm chọn kiểu 
font thích hợp trong cửa sổ font  của thanh công cụ định d

- Làm đậm, nghiêng, gạch dưới văn bản: Khối chọn khối văn bản rồi bấm chuột 
trái vào các nút  để làm đậm, hiêng,  để gạch dưới. 

ạng. 
- Chọn kích cỡ chữ (Font size): Khối chọn văn bản cần thay đổi kích cỡ font chữ, 

bấm tìm chọn kích cỡ font thích hợp trong cửa font size  của tha

- Căn chỉnh văn bản về phía trái, giữa, phải hoặc đều hai bên: khối chọn phần văn 
bản, bấm chọn vào một trong các biểu tượng sau đây trên thanh công cụ định 
dạng. 

nh công cụ 
định dạng 

 

- Ta có thể sao chép định dạng bằng cách khối chọn khối văn bản mẫu,bấm biểu 
tượng  trên thanh công cụ, ch chuột đến phần v  bản cần sao c

để làm ng

 

dạng rồi bấm chuột trái và kéo miết chuột. 
h dạng đoạn văn bản (paragraph): 
Đoạn v
phím enter.  
Paragraph sau sẽ có định dạng giống paragraph trước đó. 
Giả sử có nhiều paragraph, mỗi paragraph c

ỉ ăn hép định 

d) Địn
- ăn bản hay còn gọi là paragraph: là phần văn bản giới hạn bởi hai lần gõ 

- 
- ó định dạng khác nhau, ta có thể sao 

cho một paragraph khác. Cách làm là: đặt chép định dạng của paragraph này 
con trỏ vào paragraph mẫu, bấm chuột trái vào biểu tượng  sau đó chỉ chuột 
đến paragraph khác và bấm chuột trái thêm một lần nữa. 
Sau đây là cá
+   Đặt con trỏ vào đầu một paragraph hoặc bôi đen để chọn đoạn văn bản đó, 

vào mục menu Format chọn mục paragraph. 
+    Chỉ định một số mục cho hộp thoại dưới đây: 

e) Đ
 

ánh số trang văn bản 

chọn mục Page Number, 
ta nhận được hộp thoại có 
cấu  trúc sau. 

  page thì 
ngược lại. 

- Chọn căn chỉnh vị trí của con số chỉ trang: Right thì 
Left nằm bên trái, Center nằm ở giữa. 

- Bấm OK để đồng ý. 
 
 

- Vào menu Insert 

ch tiến hành định dạng một paragraph. 

- Chọn vị trí đánh số 
trang trong hộp Position, 
nếu chọn Bottom of page 
thì con số trang sẽ nằm ở 
phía dưới trang giấy, nếu 
chọn Top of

số chỉ trang nằm bên phải, 
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f)  đầu trang và cuối trang Tạo tiêu đề
- Vào menu View chọn Header And Footer, xuất hiện thanh công cụ sau. 

 

uố

- Bấm chọn  để vào phần không g
màn hình soạn thảo chính sẽ mờ đi, nh

trang. 
- Bấm nút Close để chấm dứt công việc tạo tiêu đề cho mỗi trang in. 

Tác dụng của lệnh: Insert Auto Text 

ian soạn thảo tiêu đề đầu trang. Lúc này 
ường chỗ cho công việc tạo tiêu đề trang. 

n trên 
mỗi tiêu đề của trang giấy. Bấm chọn nút lệnh

- Tại vị trí con trỏ màn hình nhấp nháy, nhập phần văn bản cần xuất hiệ

Đánh số trang 
 

 một lần nữa để chuyển  sang 
phần nhập tiêu đề cuối trang, tiến hành tiếp tục nhập văn bản tạo tiêu đề c i 

 

Tác giả, Số trang, Ngày tháng 
năm 
 
 
 
 
Tên tập tin,đường dẫn nơi lưu 
rữ t

 
 

+ Đánh số trang in:  

+ Chèn giờ, phút, giâ ệ

+ Định dạng con số chỉ trang in:  

+ Định dạng trang in:  

+ Chèn ngày, tháng, năm hiện hành:  

Ở mức độ thông dụng ta chỉ cần tạo đư
đạt yêu cầu. 

y hi n hành:  

Bu lete, Numbering, Tab. 
- t bi u tượng hoặc số (Bu  

 
ợc tiêu đề đầu trang, cuối trang, đánh số  

trang in là 
 
g) l
Đặ ể llete And Numbering): Bullete, Numbering là các biểu 
tượng hoặc số dẫn đầu một đoạn văn bản. Mỗi khi xuống hàng sang một đoạn khác 
thì các Bullete hoặc Numbering sẽ tự động được điền vào cho mỗi đoạn. 
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Vào menu Format chọn mục “Bullete And Numbering uất 
hiện.                                                                                               vi 

- Đặt Tab 
Trên bàn phím có phím Tab, phím này chỉ điểm i nhấn 

Tab thì con trỏ sẽ nhảy đến vị trí do ta chỉ định khoảng ó. Các 
loại Tab gồm 

uất 
hiện.                                                                                               vi 

- Đặt Tab 
Trên bàn phím có phím Tab, phím này chỉ điểm i nhấn 

Tab thì con trỏ sẽ nhảy đến vị trí do ta chỉ định khoảng ó. Các 
loại Tab gồm 

” sẽ có hộp hội thoại x
                     

dừng của con trỏ. Kh
 cách cho phím Tab đ

i thoại x
                     

dừng của con trỏ. Kh
 cách cho phím Tab đ
ab căn giữa,  Tab c

của Numbering. Nếu 

 là Tab căn trái,  Tab căn phải,  

Cách đặt tab trên thước: 
+ Bấm chọn biểu tượng Tab trên thước là Tab trái, phải, giữa,... rồi chỉ chuột 

vào  trí cần đặt Tab trên thước, bấm phí rái. Trong hình dưới đây lúc 
này ta đã đặt được 2 Tab có bước nhảy là m và 11.5 cm. 

T ăn lấy 
chuẩn là dấu phân cách phần thập phân. 
Ta ab 
hoặ

vị m t vẽ 
4 c

có thể đặt các điểm dừng cho phím Tab này và chỉ định các ký tự dẫn trước T
c cách căn chỉnh văn bản dựa trên vị trí của Tab. 

Trong thẻ này có các 
hộp, hộp chứa chữ 
None nếu được chọn 
sẽ không có Bullete 
dẫn đầu, các hộp còn 
lại chứa các biểu 
tượng hình ảnh của 
Bullete. Nếu muốn 

Trong thẻ này có các 
hộp, hộp chứa chữ 
None nếu được chọn 
sẽ không có 
Numbering dẫn đầu,
các hộp còn lại chứa 

 

các dạng số dẫn đầu 

 

 

 
 

ước ta chỉ chuột trái vào biểu tượng Tab trên thước 

 
ách đặt ký tự dẫn trước tab: 

Vào mục Format trên thanh menu, chọn mục Tab, thực hiện theo chỉ dẫn: 

+ Muốn gỡ bỏ Tab trên th
muốn bỏ, nhấn và giữ nguyên chuột trái kéo ra ngoài màn hình đang soạn 
thảo. 

C
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1.4 Tạo bảng (Table). 
Một bảng biểu (table) là một hình chữ nhật gồm có nhiều dòng (rows) và nhiều 

cột (columns). Phần giao của một dòng và một cột được gọi là ô (cell). Ngoài ra,  trên 
một trang cũng có thể chia thành một vài cột giống như cột báo, việc này đôi khi cũng 
rất cần cho việc trình bày hoặc soạn giáo án. 

a) Cách tạo bảng biểu) Cách tạo bảng biểu: 

 

muốn tạo bảng. 
- 

ộp Fi d of column 

 
Au  iữa 
hai n u 
nha  tự 
độn ứa trong nó. Nếu Autofit Windows được chọn 
thì bản ng cửa sổ trình duyệt trang WEB.  

- 

- Đặt con trỏ tại vị trí 
Vào menu Table bấm chọn Insert, sau đó chọn Table, ta nhận được hộp hội 
thoại  

 
- Gõ vào số lượng cột trong hộp 

Number of columns. 
- Gõ vào số lượng dòng trong hộp 

Number of rows. 
- Chỉ định độ rộng của các cột 

trong h xe
width. 
Nếu Fixed column width và

to thì bảng tự động điền vào g
 ra h giới lề, kích thước các cột đề
u. Nếu là Autofit to contents thì
g cột sẽ bao lấy nội dung văn bản ch

g sẽ thu gọn sao cho nằm tro
nBấm út OK 
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b) Các thao tác cần thiết khi tạo bảng 

Ngoài cách dùng trình thanh đơn chỉ định cụ thể việc tạo bảng ta còn có thể áp 
dụng theo cách sau: bấm chột trái vào nút  trên thanh công cụ, gi

trái lên đường biên của dòng kẻ 
trên cùng sao cho  con trỏ có 
hình dạng mũi tên ↓ và bấm 

ữ nguyên và quét 
chọ

Chèn thêm cột
n số cột cần tạo. 

: bấm chuột 

chuột 

 
Xóa cột:

trái để chọn đánh dấu cột 
đó. Vào menu Table chọn Insert 
→ Table → Column to the Left 
để chèn cột mới bên trái cột đã 
chọn. 

 bấm chuột trái lên 
đường biên của dòng kẻ trên cùng sao 
cho con tr n
bấm ch

ỏ có hì h dạng mũi tên ↓ và 
uột trái để chọn đánh dấu cột đó. 

Vào menu Table chọn Delete → Table 
→ Columns để xóa cột đã chọn. 

Thêm hàng, xóa hàng:  
Thực hiện tương tự như cột 

nhưng  thì ta chọn Rows. 
Chia một cột, hàng, ô thành nhiều cột, 

 tthay vì ta chọn  column

hàng, ô:  
Vào menu Table, chọn Draw Table ta thấy xuất 
hiện thanh công cụ Table and Border, bấm chọn 
biểu tượng bút vẽ → chỉ chuột vào ô hoặc cột 
cần chia → bấm chuột trái kéo. Sau đó lại bấm 
vào bút để rời bỏ việc chọn bút  Ngoài ra ta 
có thể không dùng bút để chia. Thay vì bấm vào 
bút ta bấm chuột trái vào biểu tượng Split 
ại dưới đây. Ta nhập vào ô Number of columns 
ows một số chỉ số lượng hàng, bấm OK 
ột ô: 

Khối chọn các ô, cột hoặc hàng lại → Vào menu Table, chọn Draw Table ta 

thấy xuất hiện thanh công cụ Table and Border, bấm chọn biểu tượng merge ce

Cell, sau đó ta sẽ nhận được hộp tho
một số chỉ số lượng cột, Number of r

Trộn nhiều cột, hàng, ô thành m

lls  

chuột vào nút  sao cho xuất hiện hình ảnh biểu thị cách căn chỉnh. Sau đó ta 
bấm chọn cách căn: đỉnh, đáy, trái, phải,....sao cho vừa ý. 

b) c hết ta khối chọn phần văn bản và chỉ Căn chỉnh văn bản trong bảng: Trướ
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1.5 Chèn các đối tượng vào văn bản. 
Không phải mọi ký tự, dấu hiệu cần thiết cho việc soạn thảo và trang trí văn bản 

đều có sẵn trên bàn phím, MS Word để riêng các dấu hiệu và các ký tự đặc biệt  này 
ác dấu hiệu. 

a) 
(Symbol) và cho phép chèn vào văn bản. C

Cách chèn ký tự, dấu hiệu đặc biệt (Symbol) 

 

m 

 
- Tại vị trí muốn chèn vào menu Insert chọn mục Symbol, sẽ xuất hiện hộp hội 

thoại. 
- Lựa chọn biểu tượng của Symbol cầ  chèn và bấm Insert, sau đó bấ Close. 

b) hình ảnh (Picture) 

Insert → Picture → Clip 
Art. 

i 
hình sẽ xuất hiện hộp 

thoại, ta chọn Clip 
t màn hì

Colections, chọn tiếp danh mục phân nhóm hình ảnh, lựa 
dể sao chép, đóng lại giao diện này, nhấn Ctrl + V để dán

 

n
 

Cách chèn 
Bước 1: Vào menu 

 
Bước 2: Bên phả

màn 

Organizer ở cuối màn hình, sau đó xuất hiện tiếp mộ nh khác, chọn Office 
chọn hình ảnh, nhấn Ctrl + C 
 ảnh ra màn hình soạn thảo. 

Ngoài ra ta có thể bấm nút Search để thấy các hình ảnh, bấm chọn ảnh đó. 
Ta cũng có thể chèn tập tin ảnh hoặc nối tập tin Word lưu trữ ở một thư mục 

nào  đó vào văn bản đang soạn thảo bằng cách chọn mục File → tìm đến File cần chèn 
→ bấm Insert. 

 10



 
 

c) 

độc lập với văn bản, ta phải tiến hành định dạng lại hình ảnh.  
ình ảnh, chọn Format Picture, ra tiếp hộp thoại 

cho
Bư

re (nằm 
riêng t

hind Text (nằm sau ảnh), In font of text (năm trước) 

Bước 3: Sau khi định dạng vị trí xong ta định dạng đường bao cho ảnh: Chọn thẻ 
Color and Lines. Thông thường ta chỉ nên chọn mục Line (đường thẳng bao xunh 
quanh ảnh), Style (mẫu đường bao lớn hay nhỏ), Color (màu sắc của đường bao) 

Định dạng hình ảnh (Picture) 
Sau khi có hình ảnh chèn vào văn bản, thông thường hình ảnh thường có kích  

thước l n, nằm ớ
Bước 1: Bấm chuột phải vào h

 phép ta định dạng ảnh. 
ớc 2: Chọn mục Layout để định dạng vị trí ảnh so văn bản thông qua các biểu 

tượng In Line with text (nằm riêng trong văn bản, chiếm một số dòng), Squa
rong văn bản nhưng chiếm diện tích hình vuông), Tigth (Năm riêng, song văn 

bản được điền sát với ảnh), Be

 
 

d) Sử dụng các chức năng của thanh Drawing 
Bật thanh công cụ Drawing: Vào menu View → Toolbars → Drawing. Thanh 

ày thông thường nằm ở dưới đáy màn hình. Muốn tắt thanh Drawing ta làm lặp lại 
hư

ing, chứa các mục liên quan đến 

 phần chú thích. Muốn thực hiện ta lựa chọn lấy một đối tượng, 

ần văn bản trong AutoShapes. 

n
n  vậy một lần nữa. 

- Hộp Draw: nằm ở bên trái nhất của thanh Draw
việc định dạng đối tượng đã vẽ. 

- Hộp AutoShapes: chứa các đối tượng có thể soạn thảo văn bản trong nó, thích 
hợp với tạo các
bấm chuột trái ra vùng cần tạo AutoShapes. Bấm chuột phải vào nó, chọn Add 
Text hoặc Edit Text để thêm ph

- Vẽ đường thẳng, hình chữ nhật, hình elip, hình tròn, được  thực hiện qua 
việc chọn vào một trong các biểu tượng. Muốn vẽ ta bấm chọn nó, chỉ chuột ra 
vùng muốn vẽ bấm trái và kéo miết chuột.  dạng hình ảnh. 
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- Tiến hành định dạng: Thực hiện giống như đối tượng Text Box hoặc hình ảnh 
đã học 

 1.6

bản in ra lo ấy khổ như thế nào, văn bản nằm ngang hay nằm dọc trang in, lề tính 
n ải chỉ định cụ thể loại máy in, trang 

in, số b

Bấm chọn thẻ Margin để định dạng lề: nhập kích thước vào các hộp sau: hộp kích 
thước Top chỉ phần lề từ mép trên đỉnh tờ giấy xuống phần văn bản. Hộp Bottom 
chỉ phần lề từ mép đáy tờ giấy lên phần văn bản. Hộp Left chỉ phần lề từ mép trái 

 Định dạng trang văn bản, In ấn văn bản 
Thông thường ban đầu ta chỉ nhập nội dung văn bản, chưa quan tâm đến văn 

ại gi
từ biê  của tờ giấy in vào phần văn bản. Lúc in ph

ản copy,... 
a) Định dạng trang văn bản 
- Vào menu File chọn mục Page Setup, sẽ xuất hiện hộp thoại. 

tờ giấy đến phần văn bản. Hộp Right chỉ phần lề từ mép phải tờ giấy đến phần văn 
bản. 
- Trong thẻ Margin có phần Orientation để chọn hướng tờ giấy in: chọn 

Portrait để in theo hướng thẳng đứng của tờ giấy, Landscape in theo hướng 
ngang của tờ giấy. Các hộp còn lại thông thường để ở chế độ mặc định. 

- Bấm thẻ Page để chọn các thông số liên quan đến giấy in: 
 

 
 

Chọn khổ giấy in trong hộp Paper size. Thông thường có hai khổ giấy hay gặp, 
khổ A4 kích thước chiều cao (Height) 297mm, chiều rộng (Width) 210 mm. 
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Khổ giấy A3 kích thước gấp đôi khổ A4. Các hộp còn lại thông thường để chế 

- 

i được cài đặt với 
má nhận dạng được loại máy in này. Việc cài đặt máy in được tiến 
hàn a CD chứa chương trình cài đặt máy in đó. 

ng kế) 
- 

p Name chứa tên của loại máy in đã cài đặt. Nếu máy 
ực tiếp với 

độ mặc định. 
Bấm nút Default để xác định từ đây về sau các trang giấy sẽ định dạng theo chế 
độ vừa xác lập, bấm OK để hoàn tất việc định dang trang in. 

b) In ấn văn bản 
Để in ấn được văn bản trước hết phải có máy in, máy in phả

y tính để máy tính 
h thông qua một đĩ

Ta chỉ in văn bản khi đã tiến hành soạn thảo và định dạng xong văn bản. Các 
thao  tác in tiến hành như sau: 

- Vào menu File chọn Print ta nhận được hộp thoại (xem tra
Hộp Printer chỉ các thông số liên quan đến máy in. Nếu máy tính chỉ cài đặt 
một máy in thì trong hộ
tinh cài đặt nhiều loại máy in thì ta chọn loại máy in nào đang nối tr
máy tính. 

 
 

- Hộp Page Range có 3 nút. Nút All nếu được trọn sẽ là in tất cả các trang có 
trong văn bản. Current Page là in trang hiện tại con trỏ màn hình đang đ
Pages là chỉ định cụ thể in trang số mấy. Nếu nhập 3 là in trang số 3, nhập 3-5 

- 
Lư

trang.  một trang thì ta không cần chỉ định thông số in 
the á

ứng. 

thì in từ trang 3 đến trang 5. 
Hộp Copies chỉ số bản in cho mỗi trang in. Mặc định là 1 bản cho mỗi trang in.  
u ý: Trường hợp trên chỉ áp dụng cho việc chỉ định in cụ thể, văn bản có nhiều 
Trong trường hợp văn bản có

o c ch trên mà bấm trực tiếp vào biểu tượng chiếc máy in trên thanh công cụ. 
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2. Microsoft Excel 

2.1 Đặc điểm cuả Excel   
Excel là một bộ phận của Microsoft Office, chuyên dùng để tính toán trong môi 

trường Windows. Có đặc tính và ứng dụng tiêu biểu sau: 
- Thực hiện được nhiều phép tính từ đơn giản đến phức tạp. 
- Tổ chức và lưu trữ thông tin dưới dạng Bảng tính (Sheets)  
- Tạo dựng đồ thị rất thuận tiện  
- Khi có thay đổi dữ liệu, bảng tính tự động tính lại cho kết quả mới 

2.2 Khởi động Excel  
- Nháy nút trái chuột vào biểu tượng Excel trên thanh Shortcut Bar của 

Microsoft Office 
- Nhấn nút Start/Program / MS Excel 

2.3 Màn hình Excel   
Sau khi khởi động xong màn hình Excel xuất hiện  

 
                                                           Hình 1 

Trong đó: 
   Tilte Bar:  Thanh tiêu đề 

    Menubar: Thanh menu lệnh  
     Standard Toolbar: Thanh công cụ  chuẩn  

       Formating bar:  Thanh định dạng  
        Thanh Formula:  Thanh công thức  
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Workbook Windows:  Tên tệp hiện trên thanh tiêu đề, phần mở rộng của file là XLS. 
Tên tệp mặc nhiên là book# (#: số thứ tự tương ứng với mỗi lần mở). Các thành phần 
của Workbook Windows là:  

- Cột (Column), ký hiệu cột từ trái sang phải bằng các chữ cái A - Z, AA -  AZ ; 
BB - BZ... có tổng số cột là 256 cột. Độ rộng mặc nhiên 9 ký tự (có thể thay đổi 
vị trí số này từ  0 đến 255). 

- Dòng (Rows): Ghi số thứ tự dòng từ trên xuống dưới  từ 1 đến 16384. 
+ Ô (cell): là giao điểm của một dòng với một cột, địa chỉ của một ô xác định 

bởi cột trước dòng sau. Ví dụ:  A1 là địa chỉ của ô nằm trên cột A ở dòng số 
1. Ô hiện hành (Select cell) là ô có khung viền quanh. 

+ Bảng tính (Sheet): là một bảng gồm có 256 cột và 16384 dòng hình trên 
trên 4 triệu ô dữ liệu, Tên bảng tính mặc định là Sheet# (# số thứ tự), một 
Workbook chứa 16 Sheet, được liệt kê từ Sheet1 đến Sheet16 (có thể nâng 
trị này lên đến 255), màn hình trên đang chọn Sheet1 của tệp Book1. 

+ Status Bar:  thanh trạng thái, chứa các chế độ làm việc hiện hành và tình 
trạng hiện hành của hệ thống nhưNumlock, Capslock..... 

+ Chế độ:   Ready: Sẵn sàng nhập dữ liệu; Enter: Đang nhập dữ liệu; Point: 
đang ghi chép công thức tham chiếu đến một địa chỉ; Edit: chế độ sửa chữa, 
Lệnh gõ vào F2.   

2.4 Các thao tác cơ bản trong bảng tính 
a) Các kiểu dữ liệu 

Trong một ô chỉ có thể chứa một kiểu dữ liệu, kiểu dữ liệu phụ thuộc vào ký tự 
đầu tiên gõ vào, có 3 kiểu dữ liệu: 

- Kiểu số (Number). Ký tự đầu tiên gõ vào phải là số từ số 0 đến 9, một số được 
nhập vào mặc nhiên là dạng General, sau đó có thể định dạng lại theo ý muốn 
bằng cách chọn Format / cells / numbers 

- Kiểu chuỗi (Text):  chữ đầu tiên phải là chữ từ A đến Z, sau đó định dạng vị trí.  
- Kiểu công thức (Formula):  ký tự đầu tiên là (=) hoặc dấu (+), kết quả tính 

toán hiện trong bảng tính phải là giá trị số, trong thành phần của mỗi công thức 
có thể gồm có: Chuỗi (phải được đặt trong cặp nháy kép), toạ độ ô, tên vùng, 
các toán tử, các loại hàm số các toán tử dùng trong công thức 
+ Toán tử tính toán: + (cộng); - (trừ); *(nhân); / (chia); � (luỹ thừa) ; % (phần 

trăm). 
+ Toán tử chuỗi:  & (nối chuỗi)  
+ Toán tử so sánh :  = (bằng),     < > (không bằng) ,   > (lớn hơn), >= (lớn hơn 

hoặc bằng)   < (nhỏ hơn) ,   <= (nhỏ hơn hay bằng). 
Độ ưu tiên của các toán tử trong công thức:  các nhóm biểu thức trong ngoặc 

(....), luỹ thừa, nhân, chia, cộng, trừ. 
b) Cách nhập dữ liệu vào ô 

Chọn ô cần nhập, nhập dữ liệu (theo quy ước của từng loại) kết thúc nhập bằng 
cách gõ phím enter, hay di chuyển con trỏ ô hiện hành sang ô khác bằng 4 phím điều 
khiển. ở trong chế độ sửa chữa bắt buộc phải Enter 

 c) Thoát khỏi Excel  
File/ Exit, Alt+F4  
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Nếu có thực hiện bất kỳ một sửa đổi nào trong bảng đang mở mà chưa  lưu vào 
đĩa cho đến thời điểm thoát, Excel sẽ thông báo có cất thay đổi hay không? 

2.5 Thao tác trên bảng tính Sử dụng các hàm số mẫu của Excel 
2.5.1 Thao tác trong vùng dữ liệu 

- Xoá dữ liệu trong vùng: chọn vùng, gõ phím Del 
- Hiệu chỉnh vùng dữ liệu: Bôi đen, ấn F2, có vạch nhấp nháy, thực hiện như 

đánh Text bình thường. kết thúc gõ phím Enter. 
- Khôi phục dữ liệu : Để huỷ bỏ một thao tác vừa thực hiện, có 2 cách: 

+ Dùng bàn phím: thực hiện lệnh Edit Undo, hay gõ Ctrl+Z 
+ Dùng chuột: Nháy chuột vào biểu tượng Undo trên thanh Standard toolbar  

- Sao chép dữ liệu vùng:  
+ Chọn vùng nguồn (Source) 
+ Thực hiện lệnh Edit / Copy  hoặc Ctrl+C 
+ Chọn vùng đích, có cùng dạng với vùng nguồn, hay di chuyển con trỏ ô đến 

vị trí của ô góc trên bên trái của vùng đích, thực hiện lệnh Edit/Paste hoặc 
Ctrl+V 

Khi sao chép dữ liệu nếu vùng nguồn chứa dữ liệu số hay chuỗi, kết quả vùng 
đích giống vùng nguồn. Nếu vùng nguồn chứa kiểu công thức kết quả vùng đích sẽ 
thay đổi, tuỳ thuộc vào công thức trong vùng nguồn tham chiếu địa chỉ tương đối hay 
địa chỉ tuyệt đối. 

- Sự khác nhau của việc sao chép một vùng dữ liệu có công thức tham chiếu 
địa chỉ tương đối hay địa chỉ tuyệt đối, và địa chỉ hỗn hợp: 
+ Địa chỉ tương đối: (Relative address):  

 
Ví dụ: có dữ liệu như bảng sau: 

 A B C D 
1 2 4 = A1*B1= 8 =B1*C1=32 
2 4 6 =A2*B2= 24 B2*C2=144 
3 5 7 =A3*B3=35 =B3*C3= 245 

 
Công thức ở C1 = A1*B1, khi sao chép xuống C2 = A2*B2, C3=A3*B3 
Công thức    C1 = A1*B1, khi sao chép sang D1 = B1*C1, D2=B2*C2... 
Địa chỉ A1, B1 là địa chỉ tương đối  

+ Địa chỉ tuyệt đối: (Absolute address) 
Ví dụ: có dữ liệu như bảng sau: 
 
 A B C 

1  Số tiền đổi việt nam  10.000.000  đ 
2 Ngoại tệ Tỷ giá hối đoái Số ngoại tệ đổi được 
3 Đo la Mỹ 10.000 đ C3=$C$1/B3 = 1.000 
4 Yên Nhật 250  đ C4=$C$1/B4 = 40.000 
5 Đô la Hồng Kông  2.500  đ C5=$C$1/B5 = 4.000 

     
Tính ngoại tệ đổi được từ C3 = $C$1/B3, sau đó chép công thức từ C3 xuống C4,C5, 
ta thấy địa chỉ $C$1 không thay đổi, được gọi là địa chỉ tuyệt đối. 
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+ Địa chỉ hỗn hợp (Mixed Address) 
Địa chỉ tham chiếu có dạng $<cột> < hàng> (tuyệt đối cột, tương đối hàng) ; < cột> $< 
hàng>  (tương đối cột, tuyệt đối hàng). Khi chép đến vùng đích, địa chỉ tham chiếu của 
vùng đích bị thay đổi một cách tương ứng, hoặc theo cột hoặc theo hàng  

Ví dụ: có bảng lương: 
 

 A B C D 
 Họ và tên Lương cơ bản Hệ số lương Tiền lương 
1 Nguyễn Văn Ba 210.000 6.1 D1= B$1*$C1 1.281.000 
2 Phạm văn B nt 5.4 D2=  B$1*$C2 1.134.000 
3 Lê thị Hồng nt 4.47 D3= B$1*$C3    938.700 
4 Đỗ văn Sang nt 3.9 D4= B$1*$C4    819.000 
 
Tính tiền lương cho người thứ 1:   D1= LCB*HSL= B$1*$C1 = 1.281.000, copy cho 
các người còn lại, ta thấy  D2, D3, D4 có thay đổi theo hàng ở cột C (hệ số lương của 
từng người khác nhau). 

- Chèn hàng, chèn cột, chèn ô:  

+ Chèn hàng: bôi đen số Rows cần chèn thêm. vào lệnh  Insert /Rows  (cần chú 
ý chèn rãn xuống phía dưới). 

+ Chèn cột: Bôi đen một cột tại vị trí cần chèn thêm, vào lệnh  /Insert / Column   
(luôn luôn rãn cột sang phía tay phải)  

+ Chèn Ô: bôi đen tại vị trí ô cần chèn thêm, vào lệnh Insert / Cell  (chú ý chọn 
chèn xuống phía dưới hay sang bên phải). 

- Cách đánh số thứ tự tự động:  

+ Gõ giá trị số bắt đầu vào ô đầu tiên: Chẳng hạn 1 
+ Bôi đen vùng cần đánh số thứ tự 
+ Thực hiện lệnh: Edit / Fill / Series, hộp hội thoại xuất hiện (hình 2) 
 

                                  
Hình 2 

 
Mục Series in: chọn Columns 
Mục Type: Linear (cấp số cộng), Growth (cấp số nhân), Date (dạng ngày 

tháng), Autofill (tự động), ở đây ta chọn: Linear 
Step value: bước nhẩy: 1,  2,  3,  
Stop Value: giá trị hàng cuối cùng.  Ok. 

 17



 
 

- Thao tác trên Tệp: 
+ Lưu trữ tệp trên đĩa: File / Save  (tệp mới, hoặc cũ mở ra), File / Save As 

(cất với tên khác. 
+ Mở một tệp đã có trên đĩa :  File / Open 
+ Tạo một tệp mới : File / New 
+ Đóng một tệp: File / Close  

2.5.2 Sử dụng hàm số mẫu của Excel:   Dạng tổng quát của hàm số:  
                            = < TÊN hàm> (Danh sách đối số) 
Đối số có thể là: Trị số, dẫy các ô, địa chỉ ô, tên vùng, công thức, tên hàm...  
Chú ý: Tên hàm không phân biệt chữ hoa hay chữ thường, đứng trước là dấu  (=), Đối 
số phải đặt trong ngoặc đơn (..) giữa các đối số phân cách nhau bằng dấu phẩy (,). 

- Một số Hàm số thông dụng:   
+ Hàm SUM (danh sách các trị). Tính tổng giá trị. 
+ Hàm AVERAGE (Danh sách các giá trị): tính giá trị trung bình. 
+ Hàm ROUND (biểu_thức_số, n) làm tròn giá trị của biểu thức đến  n số. 

Nếu n>0 Làm tròn về bên phải cột thập phân; nếu n<0  làm tròn về phía bên 
trái cột thập phân  

 
Ví dụ: = Round(333333,-3) cho giá trị              : 333000

                        = Round(33333.333, 2) cho gí trị          :    33333.33) 
                        = Round (12345.5432,0) Cho giá trị      :    12346 

+ Hàm MAX(danh sách giá trị) Giá trị lớn nhất. 
+ Hàm MIN(danh sách giá trị) cho giá trị nhỏ nhất.  

- Cách chọn hàm mẫu:    
+ Đặt con chỏ tại nơi cần có công thức tính  
+ Thực hiện lệnh: Insert Funtion :hoặc nháy vào biểu tượng (�(x))  thanh 

Standard Toolbar, xuất hiện cửa sổ hội thoại (hình 3) 
 

 
Hình 3 
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+ Chọn nhóm hàm cần thực hiện trong khung Select a Category 
+ Chọn tên hàm bên khung Select a Funtion   
+ Chọn OK: Đa số liệu vào number1, number2 (hình 4) 
 

 
Hình 4 

 
ấn OK kết thúc việc tính toán, cho kết quả trên màn hình. 

- Hàm IF (Điều kiện, trị đúng, trị sai): 
 - Điều kiện là một biểu thức Logic 
 - Excel sẽ kiểm tra kết quả của biểu thức: nếu đúng sẽ chọn trị thứ nhất (trị 
đúng trong cú pháp), nếu sai sẽ chọn trị thứ hai (trị sai trong cú pháp). 
 - Bản thân trị đúng, trị sai có thể là những hằng trị, biểu thức  (chuỗi, số, Logic) 
và cũng có thể là một số hàm IF. 
 

- Hàm AND (điều kiện 1, điều kiện 2, …) cho giá trị đúng khi mọi điều kiện nêu 
trong danh sách đều  cho trị số đúng. 

 Ví dụ: = AND(3>2, 5<8)  cho giá trị TRUE 
  = AND(TRUE,FALSE)  cho giá trị FALSE. 
 

- Hàm OR(Điều kiện 1, điều kiện 2, …)   cho giá trị đúng khi có bất kỳ một điều 
kiện nêu trong danh sách cho trị đúng. 

 Ví dụ: = OR(3>2, 5=8) cho giá trị TRUE 
  = O R(1+1=3, 2+3=6)  cho giá trị FALSE 

- Hàm NOT (điều kiện): cho trị đúng nếu điều kiện sai, cho trị số sai nếu điều 
kiện đúng. 

 
* Các Hàm số học: 

- Hàm ABS(N): cho giá trị tuyệt đối của biểu thức số N  
 Ví dụ: =ABS(-25)   cho kết quả là 25 
  = ABS (5-149) cho  kết quả 144 
 

- Hàm SQRT(N): cho trị là căn bậc 2 của biểu thức số N (N>0)  
 Ví dụ: SQRT(25)       cho kết quả là 5 
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- Hàm INT(N): cho trị là phần nguyên của biểu thức số N 
 Ví dụ: INT(236.26)  cho kết quả là 236 
 

- Hàm PI(): cho trị số là Pi (3.141593) 
 
 * Các Hàm số thống kê: 
 

 A B C D E F G 
1 TT Họ tên Toán Văn ĐTB vị  thứ xếp hạng 
2 1 Hùng 6 6 6.0 5 Trung bình 
3 2 Hoa 5 5 5.0 6 Trung bình 
4 3 Dũng 7 7 7.0 3 Khá 
5 4 Long 6 7 6.3 4 Trung bình 
6 5 An 4 5 4.3 7 Kém 
7 6 Hoà 9 9 9.0 1 Giỏi 
8 7 Lộc 8 7 7.7 2 Khá 

 
- Hàm COUNT(danh sách các trị): cho số các ô chứa trị số trong danh sách. 

 Ví dụ:      =COUNT(-2,"VTD",5,8)  cho kết quả 3 
       =COUNT(D1:D8)              cho kết quả 7 

- Hàm COUNTA(danh sách các trị): cho số các ô chứa dữ liệu trong danh sách  
 Ví dụ:    = COUNTA(-2,"VTD",5,8)    cho kết quả 4 
     = COUNTA(D1:D8)               cho kết quả  8 
 

- Hàm RANK(x;danh sách): xác định thứ hạng của trị x, so với các giá trị trong 
danh sách. Trị x và danh sách phải là các trị số, nếu không sẽ gây ra lỗi 
#VALUE!. Trị x phải rơi vào một trong các trị số của danh sách, nếu không sẽ 
gây ra lỗi #N/A!.  

 Ví dụ: Tại vị trí 2         = RANK(E2;E$2:E$8)    cho kết quả là 5 
      3   = RANK(E3;E$2:E$8)    cho kết quả là 6 
      7   = RANK(E7;E$2:E$8)    cho kết quả là 1  
 Ví dụ 2: sử dụng hàm IF để xếp hạng: 
 = IF(E2>=9;"Giỏi";IF(E2>=7;"Khá";IF(E2>=5;"Trung bình";IF(E2>=4.5;"Kém")))). 
 
* Các hàm số Ngày, tháng, năm (DAY, MONTH,YEAR) 
 + Kiểu dữ liệu ngày (Date). 
Dữ liệu ngày là một dạng đặc biệt của dữ liệu số. Sau đây là một số dạng trong Excel: 
 dd/mm/yy    Nếu nhập vào ô: 11/1/96,  kết quả là  11/01/96 
 dd/mmm/yy Nếu nhập vào ô: 11/1/96, kết quả là  11-Jan-96 
 dd/mmm      Nếu nhập vào ô: 11/1/96,  kết quả là  11-Jan 
 mmm-yy      Nếu nhập vào ô: 11/1/96, kết quả là  Jan-96. 
Chú ý: muốn thay đổi dữ liệu kiểu ngày theo kiểu Anh, Mỹ: Tháng/ngày/năm hoặc 
theo kiểu Việt nam  Ngày/tháng/năm, ta phải  gọi Control Panel, gọi International 
Regional mới thay đổi được. 
 
 + Các Hàm:  

- Hàm DAY(dữ liệu kiểu ngày) Cho gía trị ngày của dữ liệu kiểu ngày. 
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 Ví dụ:  = DAY(:11/1/96")              Cho kết quả là 11 
   =DAY("11-Jan-96")           Cho kết quả là 11 
   = DAY(B5)                         Cho kết quả là 15  
                                                (khi B5 chứa giá trị kiểu ngày: 15/01/96). 

- Hàm  MONTH (dữ liệu kiểu ngày) Cho giá trị tháng của dữ liệu kiểu ngày   
 Ví dụ:  =MONTH("11/1/96")        cho kết quả là: 1 
    = MONTH (D5)               cho kết quả là 2 
                  (khi A5 chứa giá trị kiểu ngày  (20/02/95) 
 

- Hàm YEAR(Dữ liệu kiểu ngày): cho giá trị năm của dữ liệu kiểu ngày. 
 Ví dụ: =YEAR("11/1/96")            cho kết quả   1996 
  = YEAR(A5)                     cho kết quả   1996 
                                              (khi A5 chứa giá trị kiểu ngày: 11/Jan-96). 
 
 * Các Hàm tìm kiếm: 

- Hàm VLOOKUP(x, Bảng, Cột tham chiếu, cách dò): dò tìm trị x cột bên trái 
của bảng, khi tìm có thì lệch qua bên phải đến Cột tham chiếu để lấy trị trong ô 
ở đó ứng với vị trí của x. 

 Bảng: Là một khối các ô, thường gồm nhiều hàng và nhiều cột. Cột bên trái 
luôn luôn chứa các trị số để dò tìm, các cột khác chứa các trị tương ứng để tham chiếu  
           Cột tham chiếu: Là thứ tự của cột (tính từ trái của bảng trở qua phải ), cột đầu 
tiên của bảng là cột 1. 
      Cách dò: là số 0 hoặc số 1. Ngầm định là 1. 
 - Nếu cách dò là 1: 
 . Danh sách ở cột bên trái của bảng phải xếp theo thứ tự tăng dần  
 . Nếu trị dò x nhỏ hơn phần tử đầu tiên trong danh sách, hàm cho trị là 
#N/A(Not Available: bất khả thi). 
 . Nếu trị số dò lớn hơn phần tử cuối cùng trong danh sách, xem nhưtìm thấy ở  
phần tử cuối cùng. 
 . Nếu trị số dò x đúng khớp với một phần tử trong danh sách (không phân biệt 
chữ hoa hay chữ thường nếu là chuỗi), đương nhiên tìm thấy ở tại phần tử đó, và cho 
trị là trị của ô nằm trong cột  tham chiếu cùng hàng với phần tử này. 
 - Nếu cách dò là số 0: 
 . Danh sách ở cột bên trái của bảng không cần phải xếp theo thứ tự. 
 . Nếu trị dò x không đúng khớp với bất kỳ phần tử nào trong danh sách (không 
phân biệt chữ hoa hay chữ thường nếu là chuỗi), hàm cho trị là #N/A (Not Available) 
bất khả thi) 
 . Chỉ khi nào trị dò đúng khớp với một phần tử trong danh sách (không phân 
biệt chữ hoa hay chữ thường nếu là chuỗi), mới cho trị là trị của ô nằm trong cột tham 
chiếu cùng hàng với phần tử này. 
 
 Ví dụ: Tính lương cho 3 loại công lao động khác nhau, biét rằng số tiền cho 
từng loại công lao động là: Loại A: 20000 đồng/ công, loại B: 10000 đồng/công, loại 
C: 5000 đồng /công. Tiền lương được tính theo công thức:  
  Tiền lương = số công * số tiền một công. 
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 Ta thực hiện như sau: 

- Tạo bảng gồm 2 cột, cột A chỉ các loại công lao động (A,B,C) và cột B chỉ số 
tiền công tương ứng  

- Chọn ổ E6, nhập công thức: =VLOOKUP(C6,$A$1:$B$3,2,1)*D6, copy 
công thức này xuống các ô E7, E8 
Ta có kết quả: 
 

 A B C D E 
1 A 20000    
2 B 10000    
3 C 5000    
4      
5 TT Họ và Tên Loại số công Tiền 
6 1 Tuấn A 28 560000 
7 2 Anh C 25 125000 
8 3 Hùng D 17 85000 
9 4 Thanh B 27 270000 

Nếu công thức ở ô E6 là:=VLOOKUP(C6,$A$1:$B$3,2,0)*D6, thì ta có kết quả: 

TT Họ TÊN LOạI Số CÔNG TIềN 
1 Tuấn A 28 560000 
2 Anh C 25 125000 
3 Hùng D 17 #N/A 
4 Thanh B 27 270000 

 
Chú ý: Trong công thức ta dùng địa chỉ tuyệt đối $A$1:$B$3 để đảm bảo địa chỉ này 
không bị thay đổi trong quá trình copy. 

+ Hàm HLOOKUP (x, Bảng, 
Hàng tham chiếu, cách dò). 
 Mọi nguyên tắc hoạt 
động của hàm HLOOKUP 
(Horizontal LooK Up) này 
giống như hàm VLOOKUP 
(Vertical Look Up) chỉ khác là 
hàm VLOOKUP dò tìm ở cột 
bên trái, tham chiếu số liệu ở 
các cột bên phải, còn hàm 
HLOOKUP dò tìm ở hàng trên 
cùng, tham chiếu số liệu ở các 
hàng phía dưới. 
 
 

2.5.3 In trong Excel 
a) Thiết kế trang in:   
Lệnh File / Page Setup hộp hội thoai xuất hiện: 
- Chọn trang in: Portrait hay Lanscape 
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b) Header and Fooder: 
Định tiêu đề đầu trang hay cuối trang, chọn lệnh nháy chuột vào khung 

Header/Fooder trên hình 15, cửa sổ xuất hiện, chọn Costum Header hay Costum 
Fooder....  Cả hai đều dẫn đến một hộp hội thoại. 

 

 
 

 
 
 
 

Chèn số 
trang tự 
động  

Chèn 
tổng số 
trang  

Chèn 
tên bảng 
tính  

Chọn 
fonts  

Chèn 
ngày 

Chèn 
Giờ 

Chèn tên 
tập tin  

Nội dung nhập vào Header/Fooder có thể trình bầy một trong ba khu vực trái, 
Giữa, Phải, muốn xuống dòng gõ Enter.  

 
c) Chọn Mục Sheet   - Print Area: Nhập địa chỉ 

vùng muốn in trên bảng 
tính hiện hành   
- Row to Repeat at top: In 
hay không in dòng tiêu đề  
-Column to Repeat at 
Left:  In hay không in cột 
bên trái 
- Gridlines: Bật /tắt những 
lần phân cách giữa các ô, 
thông thường tắt chế độ 
này  
- Notes:  Bât/tắt việc in chú 
thích  
- Page Order: thứ tự 
trang in: Không nên thay 
đổi  
- Down then Across: in từ 
trên xuống dưới, qua phải 
- Across then Down: in từ 

ố

 
 
 
d) In ra giấy:   

Trước khi in nên vào lệnh Print Preview trước, sau đó vào lệnh in. File / Print 
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